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INTRODUCTION 

HOPEX Portfolio & Planningis a tool edited by MEGA International to assist:

 Decision-makers in their choice of actions to be undertaken to achieve enterprise 
strategic objectives.

 Management in the follow-up of actions implemented to manage changes within 
the enterprise.

HOPEX Portfolio & Planning has been designed to enable:

 Definition of the content of portfolios of the enterprise and of its departments in 
terms of initiatives or initiative groups.

 Understanding, classification, balancing and planning of portfolio initiatives.
 Updating of the state of initiatives in a portfolio reflecting the implementation of 

associated programs.
 Creation of one or several master plans.
 Generation of comparison reports at functional, application and technical levels.
 Use these reports to select master plans corresponding closest to business 

function expectations;
 Set up implementation projects based on formalized methods and synchronize 

these with selected master plans.
 Generation of analysis reports on these projects: monitoring of suitability of 

projects related to master plans, action plans (roadmaps).

The purpose of this guide is therefore to present how to make best use of these functionalities for
the successful evolution of your information system.
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OVERVIEW OF HOPEX PORTFOLIO & PLANNING

Modeling with HOPEX Portfolio & Planning 

By means of portfolio management, HOPEX Portfolio & Planning enables
planning over time of development of information systems, organizations and more
generally all enterprise architecture. 
Depending on the HOPEX Suite products you have available, different object types
can be described in enterprise portfolios.

Describing and Analyzing Portfolios
You can define contents of a portfolio directly from its diagram. This offers many
advantages:

• Each initiative can be defined simply and rapidly. The icon of the object 
with which the initiative is associated appears in the diagram.

• Initiatives relating to the same program can be assembled in an initiative 
group.

• Dependency links between initiatives can be represented graphically.

HOPEX Portfolio & Planning  compares your initiatives on standard criteria such
as costs, benefits or risks. You can also define criteria specific to your context.

Reports dedicated to portfolios allow you to create charts enabling analysis of
portfolios on different comparison criteria you have defined.

Analysis reports can be grouped in a HOPEX book or integrated in an Internet site.
 You can modify the form of reports generated with HOPEX 
Portfolio & Planning and create new ones. (See chapter "Using 
Books" in the HOPEX Common Features guide).

Developing portfolios
Objects of your enterprise, such as applications or processes, will without doubt
develop. So that representation of your organization remains updated, your models
will be modified. 

Used with other HOPEX Suite products, HOPEX Portfolio & Planning allows you
to plan and follow up these developments which are transferred to all processes in
which the elements concerned intervene.

• You can quickly access objects of which development is planned.
• You can transfer the impacts of development of a process to other 

programs in which this element appears.
• You can regenerate all reports in which this object is involved.

This user guide is designed to help you quickly discover the main functionalities of
HOPEX Portfolio & Planning and how to use them.
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Introduction
Overview of HOPEX Portfolio & Planning

Connect to the solution and learn about the desktop

Web Front-End

The HOPEX Common Features guide, chapter "The HOPEX Web Front-End Desktop".

Windows Front-End

The HOPEX Common Features guide, chapter "The HOPEX Web Windows Desktop".
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PRESENTATION OF THIS GUIDE

Guide Structure

This guide presents how to make make best use of  HOPEX Portfolio & Planning
to plan strategic projects to be managed in your enterprise.

The HOPEX Portfolio & Planning guide comprises the following chapters:
• "Describing a Portfolio", page 7, explains how to create and update 

portfolio components.
• "Analyzing Portfolios", page 25, presents reports proposed by HOPEX 

Portfolio & Planning to simplify analysis of portfolio components.
• "Describing a Master Plan", page 39, explains how  to make best use of 

information defined in a master plan.
• "Advanced Modeling of Portfolio Objects", page 35, presents advanced 

functionalities of HOPEX Portfolio & Planning for modeling different 
development scenarios of objects and their costs

• "Glossary", page 65: summarizes definitions of the main concepts used 
in HOPEX Portfolio & Planning.

Additional Resources

This guide is supplemented by:
• HOPEX Common Features guide describes the basic functions common 

to HOPEX products and solutions.
 It can be useful to consult this guide for a general presentation of 
the interface.

• The  HOPEX Assessment guide, which describes the functions 
proposed by HOPEX to use and customize assessment questionnaires.

• the HOPEX Power Supervisor administration guide.
• More advanced technical functions are described in the HOPEX Power 

Studio guide.
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Introduction
Presentation of this Guide

Conventions Used in the Guide

Styles and formatting

 Remark on the preceding points.

 Definition of terms used.

 A tip that may simplify things.

 Compatibility with previous versions.

 Things you must not do.

Commands are presented as seen here: File > Open.

Names of products and technical modules are presented in bold as seen here:
HOPEX.

Very important remark to avoid errors during an operation.
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DESCRIBING A PORTFOLIO

Creating a portfolio with HOPEX Portfolio & Planning allows you to define all the information that
will then enable you to select initiatives to be implemented. 

 A portfolio enables representation of all investments of an 
enterprise (or department) necessary to carry out changes required to 
achieve strategic objectives. It comprises a set of initiatives to be 
compared based on comparison criteria associated with the portfolio.

 An initiative is a portfolio element corresponding to an investment 
program identified by the enterprise (or department) to achieve 
strategic objectives.

You will begin by:

 "Creating a Portfolio", page 8
 "Defining Criteria", page 11
 "Defining Initiatives", page 19
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CREATING A PORTFOLIO

Creating a portfolio consists of defining initiatives, comparison criteria and timelines
relating to the portfolio.

 A portfolio enables representation of all investments of an 
enterprise (or department) necessary to carry out changes required to 
achieve strategic objectives. It comprises a set of initiatives to be 
compared based on comparison criteria associated with the portfolio.

 An initiative is a portfolio element corresponding to an investment 
program identified by the enterprise (or department) to achieve 
strategic objectives.

To create a portfolio:
1. [Windows Front-End] Expand the Main Objects navigation tree.

 If this tree is not displayed, select View > Navigation Windows 
> Main Objects.

2. [Web Front-End] Click on the Repository navigation window then on 
Main Objects.

3. Right-click the Portfolio folder and select New >  Portfolio.
4. In the dialog box that appears, indicate the name of the portfolio. 
5. Indicate the owner library if required. 

By default, the portfolio is connected to the reference library.
 Libraries are collections of objects used to split MEGA repository 
content into several independent parts. They allow creation of virtual 
partitions of the repository. In particular, two objects owned by different 
libraries can have the same name.

6. Click OK.

Creating a Sub-Portfolio

To be able to closely study development hypotheses, you can divide a portfolio into
sub-portfolios, each subject to different scenarios.

To create a sub-portfolio:
1. Right-click the portfolio that interests you and select New >  Portfolio.
2. In the dialog box that appears, indicate the name of the portfolio. 
3. Click OK.

 If a scenario is associated with a main portfolio, it is not inherited 
by the sub-portfolio.
 You can create sub-portfolios from an initiative group. For more 
details, see "Creating an Initiative Group", page 20.

Propagating Criteria

The Propagate Criteria command available on a portfolio with sub-portfolios
enables addition of parent portfolio criteria to sub-portfolio criteria.

 For more information on portfolio criteria, see "Defining Criteria", 
page 11.
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Describing a Portfolio
Creating a Portfolio

Creating a Portfolio Diagram

The portfolio diagram enables representation of portfolio contents.

The procedure varies slightly depending on whether you are in Windows Front-End
or Web Front-End.

Windows Front-End

To create a portfolio diagram:
1. Right-click the portfolio name and select New > Diagram.
2. In the dialog box that appears, select Portfolio Diagram, confirm that 

the Diagram initialization check box is selected, and click the Create 
button.
The portfolio diagram window appears containing the portfolio.

 The sub-portfolios and their contents do not appear in portfolio 
diagrams.

Web Front-End

To create a portfolio diagram:
 Right-click the portfolio name and select New > Diagram.

Viewing and Updating Portfolio Contents

All elements of a portfolio are accessible from the different pages of its properties
dialog box.

To access the properties dialog box of a portfolio:
 Right-click the portfolio and select Properties.
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Defining Inventory Portfolio Content

All elements of a portfolio are accessible from its properties pages.
• Identification: name, portfolio type, study dates, comment.
• sub-portfolios : see "Creating a Sub-Portfolio", page 8.
• Portfolio Criteria: see "Defining Criteria", page 11
• Timeline: see "Using Timelines", page 17.
• inventory: This page enables listing of portfolio applications and 

evaluation of their criticality. See "Evaluating Application Criticality", 
page 56.

• Evaluation: This page enables definition of values of criteria associated 
with applications. See "Assessing Initiatives", page 22.

 A criterion is a reference element used to compare initiatives in a 
portfolio. Criterion values can be predefined.

• Report: enables creation of analysis reports on the portfolio. See 
"Accessing HOPEX Portfolio & Planning Analysis Reports", page 26.
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Describing a Portfolio
Defining Criteria

DEFINING CRITERIA

You can compare initiatives defined in a portfolio based on common criteria
associated with the portfolio.

 A criterion is a reference element used to compare initiatives in a 
portfolio. Criterion values can be predefined.

To view criteria associated with a portfolio: 
 Open the portfolio properties dialog box and display the Criteria page.

Example (Web Front-End)

In the example above, criteria essentially relate to 
financial aspects. 

To define portfolio criteria, you can:
• Use criteria already existing in the repository.
• Create new criteria and associated values.

 Criteria are defined from the MetaClass (object type) 
TaggedValue. Certain dialog boxes use this term rather than 
Criterion.

Using standard criteria

To define criteria for comparison of initiatives of a portfolio using existing criteria:
1. Open the properties dialog box of the portfolio.
2. In the Criteria page, click the Connect button.

The Select Query dialog box opens.
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3. Click Criterion for Assessment.
The list of criteria already defined is displayed in a Selection of Object
of TaggedValue Type dialog box. 

 If you click Others, the Query dialog box opens. Select the 
Registered Queries tab to access queries that are a function of the 
portfolio.

4. Select the criteria that interest you.
5. Click OK.

Selected criteria appear in the portfolio properties dialog box.

Using Existing Criteria

Standard criteria are proposed to process costs modeled on objects and initiatives.
 For more details on modeling of costs, see "Costs Modeling 
Principle", page 37.
 For more details  on initiative modeling of costs, see "Modeling 
Initiative Costs", page 22.

Standard criteria enabling analysis of costs declared on initiatives as a function of
their type and nature are the following:

• For type: 
• Capital expenses
• Operating expenses

• For nature:
• Infrastructure costs
• Software licenses costs
• Manpower costs
• Service costs

The names of standard criteria enabling analysis of costs declared on objects carry
the extension "Reference", for example "Reference Costs".

Given that certain criteria are automatically calculated, they cannot be modified
from the Initiatives tab or the Assessment subtab of the portfolio.

 For more details, see "Assessing Initiatives", page 22.

Creating a New Criterion

To create new criteria for portfolio application comparison:
1. Open the properties pages of the portfolio and select Characteristics.
2. In the characteristics, expand the Portfolio Criteria section.
3. In the section, click the New button.

The TaggedValue (criterion) creation dialog box opens.
4. Indicate the name of the site and click OK.

The new criterion appears in the list of portfolio criteria.

Defining criterion format

Specification of type and format of a criterion (or TaggedValue) is identical to that
of a MetaAttribute. For more details on declaration of criterion format, see chapter
"MetaAttributes" of the Studio guide.
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Describing a Portfolio
Defining Criteria

To define characteristics of a criterion:
1. Select the criterion and click Property.
2. Click Characteristics.
3. In the MetaAttribute Type field, indicate the type that will take the 

criterion values.

4. In the MetaAttribute Format field, indicate the Format that will take 
the criterion values. Possible values are:
• Standard: for character strings
• Currency: for currencies
• Enumeration: for a list of character strings with predefined values
• Enumeration (Opened): for a list of character strings open to the 

user 
• Duration: for dates
• Percent : to enter a percentage
• Double : to enter a number
• Object : to enter an object
• Signed Number : to enter a number possibly negative. In this case, 

MetaAttribute Type must be  Short, Long, Double or Float.
 The following formats are recognized in analysis reports: 
Standard, Enumeration and Signed Number. 

5. Click OK.

To define values associated with a criterion of Enumeration format:
1. Open the properties pages of the criterion.
2. Select External Values.
3. Click the New to create new values.

MetaAttribute Type Meaning

String Alphanumeric, the value of the MetaAttribute 
Length attribute should then be specified

DateTime Date

VarChar ASCII text

VarBinary Binary text (reserved)

Boolean Boolean (0 or 1)

Short Integer (0-65535)

Long Integer (0- 4294967295)

Binary Binary (reserved)

Double Integer (0- 18446744073709551616) 

Float Floating number
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Defining Criterion Aggregation Rules

Aggregation of a criterion enables definition of calculation rules that will be applied
to application values to obtain the criterion value on a portfolio. In this way you can
compare portfolios.

To define criterion aggregation rules:
1. Open the properties pages of the criterion.
2. Select the Characteristics page.

Aggregation policies proposed as standard are: 
• Minimum
• Maximum
• Average
• Sum

For example, the Cost criterion associated with a portfolio 
can be obtained by calculating the average cost of 
initiatives making up the portfolio, or the sum of costs of 
each of the elements.

To fix more specific aggregation rules, the aggregation policy can be defined by a
Macro. The name of the macro is defined in the Aggregation Macro column.

 For more information on Macros in HOPEX, see the  guide All 
about starting with APIs.

The result of aggregation of different criteria is accessible in the Aggregation
Value column.

Evaluating Portfolio objects

Objects connected to Portfolio initiatives are assessed related to different portfolio
criteria.

 Standard criteria relating to costs are automatically calculated, they 
cannot therefore be modified in this tab. For more details on these 
criteria, see "Using Existing Criteria", page 12.

Accessing objects to be evaluated

To access evaluations of all portfolio objects:
1. Open the properties pages of the portfolio.
2. Display the Initiative > Assessment page.

The matrix for assessment of all objects connected to portfolio initiatives
according to different criteria is displayed. 



15

Describing a Portfolio
Defining Criteria

3. To define a criterion value on an application, such as a cost, select the 
application concerned and click in the criterion column.

Generating a PDF or Excel evaluation data file

The PDF and Excel allow you to generate PDF and Excel files of evaluation results.
 For reasons of readability, the PDF file contains a maximum 12 
columns.

Generating an instant report on evaluation data

Instant reports allow you to carry out drill-down analysis on evaluated objects. They
provide greater detail depending on specific analysis perspectives (quantitative,
time, etc.).

To generate an instant report on a list of evaluated applications:
1. In the list of applications, select those to be analyzed.

If you do not select an application, by default the report covers all
applications.

2. Click Instant Report. 
3. Select the required analysis type, for example "Breakdown". 
4. Click OK. 
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5. In the list of possible grouping criteria, select "Risk of implementation".
For all selected applications, you obtain the breakdown of implementation
risks according to their level (low risk, high risk, etc.). 

 For more information on instant reports, see the paragraph 
"Running instant reports on a list of objects" in the chapter "Generating 
Documentation" of the HOPEX Common Features guide.
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Describing a Portfolio
Using Timelines

USING TIMELINES

The analysis phase of portfolio applications is based on timelines.
 A timeline presents key timespots of the organization from fixed 
dates or defined periods.

A timeline is an object specific to the enterprise and can be referenced by portfolios
or master plans.

To view timelines associated with a portfolio: 
1. Open the properties pages of the portfolio.
2. Click the Reference timeline tab.

This section is in two parts:
• Reference timeline: indicates a global calendar showing a certain number 

of timespots over a given time period. You can define a new timeline or 
connect an existing timeline.

• Owned timeline: corresponds to timeline milestones; milestones appear 
when you select a timeline in the upper part.

The above example presents a timeline for the upgrade of 
application assets. Phases of deletion of obsolete 
applications are synchronized with phases of deployment of 
new applications.

Creating a timeline

To create a timeline:
1. In the first frame of the Reference timeline section, select New.

The Timeline creation dialog box appears.
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2. Enter the name of the timeline.
3. Click OK.

The timeline is created and added to the list of portfolio timelines.

Defining timespots

The Timeline diagram allows you to define the different key events that make up
the timeline, as well as their dependency links.

To create a new timeline diagram: 
1. Click the icon of the timeline and select New > Timeline Diagram.

An empty diagram appears.

To create an  TimeSpot:

1. In the insert toolbar, click the Timespot   button, then click in the 
diagram.
The Add TimeSpot dialog box appears.

2. Indicate the name of the timespot  and click Create. 
The timespot appears in the diagram.

To specify time links between timespots, you will create a sequence flow:

1. Click the Sequence Flow button 
2. Click the timespot representing the start step, and holding the mouse 

button down, draw a line to the timespot representing the next step.
3. Release the mouse button.

A directional link from one timespot to the next appears in the diagram.
Previous and next timespots also appear in timespot Properties, in the
Characteristics page.

Dating a timespot

A timespot can be associated with a precise date or a time interval. The time interval
is defined by a date at earliest and a date at latest.

To define timeline timespot dates: 
1. Open the properties pages of the timeline.
2. Select the Characteristics page.
3. In the Owned TimeSpot section, you can date timespots.

 You can also specify sequence flows.
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Defining Initiatives

DEFINING INITIATIVES

An initiative is associated with an enterprise repository object. 
 An initiative is a portfolio element corresponding to an investment 
program identified by the enterprise (or department) to achieve 
strategic objectives.

Depending on the HOPEX  Suite products you have available, this object can be:
• org-unit
• an application
• a resource architecture,
• a capability,
• a technical infrastructure,
• an artifact,
• a business process
• an organizational process,
• a project,
• a product,
• an IT service,
• a business function,
• standard.

Several initiatives can be grouped in an initiative group to simplify portfolio
management.

 An initiative group is a set of consistent investment programs 
designed to simplify portfolio analysis and follow-up.

An initiative is associated with an enterprise repository object. 
 An initiative is a portfolio element corresponding to an investment 
program identified by the enterprise (or department) to achieve 
strategic objectives.

 "Creating an Initiative", page 19
 "Defining Initiative Characteristics", page 20
 "Specifying Initiative Life", page 21
 "Modeling Initiative Costs", page 22
 "Assessing Initiatives", page 22

Creating an Initiative

Creating an initiative from a portfolio

To add an initiative to a portfolio:
1. Right-click the portfolio and select New > Initiative.

The initiative creation dialog box appears.
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2. In the Element with Initiative field, find in the list of objects that from 
which you want to create an initiative.

3. Click OK.

Creating an Initiative Group

To create an initiative group from a portfolio diagram:

1. Click the Initiative Group  button in the toolbar.
2. Position the initiative group in the portfolio frame.

The Create Initiative Group dialog box opens.
3. In the Name field, enter the name of the group.
4. Click OK.

The initiative group appears in the diagram.

To connect an initiative to an initiative group:
 Drag the initiative into the frame representing the group.

To create a sub-portfolio directly from an initiative group:
1. Right-click the initiative group and select the command Transform to 

Sub-Portfolio.
A sub-portfolio carrying the initiative group name appears in the
navigation tree.

 The initiative group and its content disappear from the initiative 
diagram.

2. Click the sub-portfolio name, press key <F2> and enter the desired 
name.

Defining Initiative Characteristics

To access information relating to initiatives:
 Open the initiative properties pages and select the Characteristics 

page.
The object to which the initiative relates appears in the Element with
Initiative box.

Specifying decision-making information

Decision-making information is specified in the following boxes:
• Decision, which can take values: 

• Accept
• Reject
• In progress

• Decision-Maker and Decision-Maker User.
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Specifying timespots

Initiatives can be situated chronologically from timespots of the timeline associated
with the portfolio.

 For more details on timelines connected to a portfolio, see "Using 
Timelines", page 17.

The Characteristics page of an initiative presents:
• Starting Timespot and Ending Timespot, define the limits of the time 

period on which the initiative is planned.
• Timespot, defines the date at which the initiative is planned.
• Life Cycle Status of the entity that is the subject of the initiative. The 

values proposed depend on life cycle selected for initiative life.
 For more details on object life, see "", page 36.

Specifying Initiative Life

To model component development scenarios of your portfolio without impacting the
life of components, you will use initiatives and associate an object life to each of
these.

 The object life is a set of time periods representing the updated 
calendar of object life cycle states.
 For more details on object life, see "", page 36.

Initializing initiative life

To create an object life on an initiative: 
 Click the icon of the initiative and select Initialize Object Life. 

• If the object associated with the initiative already has an object life, 
the object life is duplicated and associated with the initiative.

• If not, the object life creation dialog box appears. 
 For more details on object life creation, see "", page 36.

To view life of an initiative:
 Open the initiative properties pages and select the Object Life page.

Updating object life from an initiative

The different component development scenarios of a portfolio are studied through
initiatives connected to one or several scenarios. When a scenario is adopted, you
can automatically update the life of objects associated with portfolio initiatives from
the initiatives.

To update object life from initiative life: 
 Click the icon of the initiative and select Validate Transformation.

The object life is updated from the initiative life.
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Modeling Initiative Costs

To view costs defined on an initiative:
 Open the initiative properties pages and select the Costs page.

 For more details on principles of modeling costs of components and 
initiatives, see "Costs Modeling Principle", page 37.

Assessing Initiatives

Portfolio initiatives are assessed related to different portfolio criteria.
 Standard criteria relating to costs are automatically calculated, they 
cannot therefore be modified in this tab. For more details on these 
criteria, see "Using Existing Criteria", page 65.

To access initiatives of all portfolio applications:
1. Open the properties pages of the portfolio.
2. Display the Initiatives > Assessment page.

The matrix for assessment of all portfolio initiatives according to different
criteria is displayed. 

3. To define the value of a criterion, such as a cost, on an initiative, select 
the initiative concerned and click in the criterion column.

4. Specify values of the different criteria on each initiative.
5. Click OK.
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USING SCENARIOS

Several initiatives can relate to the same application, in the same portfolio, to
represent different hypotheses (exclusive between themselves) of the same
application.

scenarios can then be created by selection of a set of initiatives to be produced. The
different scenarios created can be compared by means of specific reports:

 A scenario is a projection in time of development of real objects 
through initiatives.

 "Creating a Scenario", page 23
 "Accepting or Rejecting Scenario Initiatives", page 23

Creating a Scenario

A scenario is a coherent set of initiatives enabling costing of a hypothesis in a
transformation portfolio.

To create a scenario on a portfolio:
1. Click the icon of the desired portfolio and select New  >  Scenario.

The scenario is created with a default name. It is also automatically
connected to initiatives of the portfolio.

You can open its properties to modify its name if necessary or to define its
properties.

Accepting or Rejecting Scenario Initiatives

An initiative must be accepted in order to be taken into account in a given scenario.
Conversely, an initiative must be rejected if you want the scenario to ignore it.

To define initiatives to be taken into account in a scenario:
1. Open the properties pages of the portfolio you want to study.
2. Display the Initiatives > Scenario page.

The list of initiatives connected to the scenario appears in the Initiatives
section.

3. In the matrix, click the cells at intersections of initiatives and scenarios 
and select one of the following values:
• In progress: the initiative is under study, it is integrated in the 

scenario
• Rejected: the initiative is not taken into account in the scenario
• Accepted: the initiative is integrated in the scenario
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ANALYZING PORTFOLIOS

HOPEX Portfolio & Planning offers analysis and follow-up of portfolio implementation based on
reports. 

MEGA Suite uses reports to group sets of repository objects and study their interactions. 

 "Accessing HOPEX Portfolio & Planning Analysis Reports", page 26
 "Presentation of HOPEX Portfolio & Planning Reports", page 27
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ACCESSING HOPEX PORTFOLIO & PLANNING ANALYSIS 

REPORTS  

The different report templates proposed as standard by  HOPEX Portfolio &
Planning are designed to compare initiatives of a portfolio based on specific
criteria. Different report types offer different analysis possibilities. 

To access existing reports on a portfolio or to create new reports from report
templates:

1. Right-click the portfolio and select the Documentation >Report 
Discovery command.
The list of report templates is displayed in the edit window. They are
classified by folders corresponding to different categories.

2. Click button   on the right of a folder to view the proposed report 
templates.

Report templates can contain one or several parameters. Certain parameters are
defined automatically with the value of the selected object. Other parameters must
be specified. Depending on the report template, you can:

• directly launch the report
• modify default values and launch the report
• enter missing parameters and launch the report.

For more details on reports creation, see the guide,  "Generating documentation",
"Generating analysis reports"HOPEX Common Features.
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PRESENTATION OF HOPEX PORTFOLIO & PLANNING 

REPORTS

A report is created from a report template. HOPEX Portfolio & Planning supplies
following reports:

 "Pie Chart of Initiatives", page 27
 "Evaluating Portfolio Initiatives", page 28
 "Bubble Chart of Initiatives", page 29
 "Bar Chart of Initiatives", page 31
 "Stacked Bar Chart of Initiatives", page 32
 "Radar Chart of Initiatives", page 33

Pie Chart of Initiatives 

The pie chart enables assessment of the contribution of each initiative on a
particular criterion. Use this type of chart when all values are positive.

The example below shows cost distribution of the different 
applications.

 If you relate your analysis to several criteria, costs and expected 
benefits for example, you obtain a diagram for each of the criteria.
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Report parameters
This consists of defining report input data. 

Report options

This report template can be displayed with the following options:
• Display of percentages
• Detached sector
• 3D Depth

 For more details on specification of report options, see "Modifying 
Report Display Parameters" in chapter "Generating Documentation" of 
the  HOPEX Common Features guide.

Evaluating Portfolio Initiatives

This report gives values of selected criteria for all portfolio initiatives.
The example below shows fixed values for each of the 
portfolio initiatives.

Parameter Parameter object 
type Constraints

Report subject Portfolio
Initiative group
Scenario

At least one subject mandatory. Ini-
tiatives are cumulated.

List of criteria Criterion Mandatory
One chart per criterion.
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Presentation of HOPEX Portfolio & Planning Reports

Report parameters
This consists of defining report input data. 

Bubble Chart of Initiatives

The bubble chart enables comparison of initiatives on a maximum of four different
criteria. You must specify the criteria presented on the X-axis and the Y-axis and
define bubble color and size.

The purpose of the example below is to compare cost aspects 
of different initiatives (X-axis), benefits (Y-axis), 

Parameter Parameter object 
type Constraints

Report subject Portfolio At least one subject mandatory. Ini-
tiatives are cumulated.

List of criteria Criterion Mandatory
One column per criterion.
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suitability to enterprise strategy (bubble size) and risks 
related to costs (bubble color).

 The key to chart bubbles is presented at the bottom of the chart.

Report options
This consists of defining report input data. 

Parameter Parameter object 
type Constraints

Report subject Portfolio
Initiative group
Scenario

At least one subject mandatory. Ini-
tiatives are cumulated.

X-axis Criterion Mandatory and unique.

Y-axis Criterion Mandatory and unique.

Color Criterion Optional, one maximum.

Size Criterion Optional, one maximum.
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Bar Chart of Initiatives

The barchart enables comparison of initiatives based on a specific criterion.
The example below shows comparison of costs of different 
business applications.

 If you relate your analysis to several criteria :  costs and expected 
benefits for example, you obtain a diagram for each of the criteria.

Report parameters
This consists of defining report input data. 

Report options

This report template can be displayed with the following options:
• Form of bars
• Horizontal chart
• 3D Depth

 For more details on specification of report options, see "Modifying 
Report Display Parameters" in chapter "Generating Documentation" of 
the  HOPEX Common Features guide.

Parameter Parameter object 
type Constraints

Report subject Portfolio
Initiative group
Scenario

At least one subject mandatory. Ini-
tiatives are cumulated.

List of criteria Criterion Mandatory
One chart per criterion.
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Stacked Bar Chart of Initiatives

The stacked bar chart enables comparison of initiatives on several quantitative
criteria. Values associated with each criterion for the different initiatives are stacked
on the same bar.

The example below shows costs, benefits and revenues 
distribution for the different business applications.

Report parameters
This consists of defining report input data. 

Report options

This report template can be displayed with the following options:
• Form of bars
• Horizontal chart
• Bars in ascending order
• Order of configured bars
• 3D Depth

 For more details on specification of report options, see "Modifying 
Report Display Parameters" in chapter "Generating Documentation" of 
the  HOPEX Common Features guide.

Parameter Parameter object 
type Constraints

Report subject Portfolio
Initiative group
Scenario

At least one subject mandatory. Ini-
tiatives are cumulated.

List of criteria Criterion At least one criterion mandatory.
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Radar Chart of Initiatives

A radar chart enables comparison of each initiative on criteria with different but
comparable values. A radar chart is automatically created for each initiative of the
portfolio or initiative group.

The axes of a radar chart are calculated on the basis of maximum value calculated
on all the values of criteria represented.

 To obtain a radar chart, at least three criteria must be defined for 
comparison.

The example below shows the position related to calculated 
costs, expected revenues and benefits. Note that the 
maximum value is revenue expected for all initiatives.

Report parameters
This consists of defining report input data. 

Report options

This type of report can be displayed with the Stack all initiatives on a chart.
 For more details on specification of report options, see "Modifying 
Report Display Parameters" in chapter "Generating Documentation" of 
the  HOPEX Common Features guide.

Parameter Parameter object 
type Constraints

Report subject Portfolio
Initiative group
Scenario

At least one subject mandatory. One 
initiative per chart.

List of criteria Criterion At least three criteria mandatory.
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ADVANCED MODELING OF PORTFOLIO 
OBJECTS

This chapter presents the concepts used in HOPEX Portfolio & Planning.

 "Object Life Concept", page 36
 "Costs Modeling Principle", page 37
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OBJECT LIFE CONCEPT

Object life represents development of a component of your repository as it is really
planned following analyses carried out. 

 The life of an object is a set of time periods representing the real 
calendar of object states.

To represent another development scenario, without impacting what exists, you will
associate initiatives with objects of your portfolio. The life of each initiative enables
representation of different development scenarios for all objects. 

To enable detailed analysis of portfolio development scenarios and the associated
costs, HOPEX Portfolio & Planning enables description, from an object life, of the
planning of steps in the object life cycle. 

An object life can be defined for:
• a project
• an org-unit
• a business process
• an organizational process
• a business function service
• a capability
• an application
• an application service
• a resource architecture
• a technical infrastructure
• an artifact
• a node
• workstation
• a network
• a server
• a standard
• an initiative
• master plan

See:
• "Viewing Application Life (Gantt Chart)", page 42,
• "Specifying Object Life", page 43,
• "Defining Life Cycle of an Object Type", page 45.
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COSTS MODELING PRINCIPLE

The aim of modeling costs with HOPEX is to be able to compare the cost of different
components and to compare the different evolution scenarios on identical financial
criteria.

To be able to take account of the time (past and future), the cost of a component is
represented by a fixed part and a periodic part.

For example, a purchase price is specified in a fixed part, 
and annual maintenance in a periodic part.

Finally, costs are characterized by different criteria that enable more detailed
comparison. Criteria are:

• a type to distinguish investment costs.
• a nature to isolate costs of infrastructure, license, service or manpower.
• life cycle of the component concerned.

The aim of modeling costs with HOPEX Portfolio & Planning is to be able to
compare the cost of different components and to compare the different evolution
scenarios on identical financial criteria.

To be able to take account of the time (past and future), the cost of a component is
represented by a fixed part and a periodic part.

For example, a purchase price is specified in a fixed part, 
and annual maintenance in a periodic part.

Finally, costs are characterized by different criteria that enable more detailed
comparison. Criteria are:

• the type to distinguish investment costs.
• the nature to isolate costs of infrastructure, license, service or 

manpower.
• life cycle of the component concerned.

 "Cost Calculation Principles", page 37
 "Specifying Costs Components", page 38
 "Specifying a Currency", page 40

Cost Calculation Principles

Each fixed expense is associated with an amount and a date. 

Each periodic expense is associated with an initial amount, a start date, and the
amount and periodicity of timespots. 

 For more details on modeling of costs, see "Creating a fixed 
expense", page 39 and "Modifying a periodic expense", page 40.
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The cost of the object can be calculated in the absolute, or in the context of an
initiative of a portfolio. In the case of an initiative, sums are calculated between
begin date and end date of the portfolio.

We assume for example that retirement of an application 
starts in July with a decreasing periodic cost. The periodic 
cost is 500€ and the decreasing cost -100€.

The cost calculation formula proposed as standard in HOPEX  is based on fixed and
variable cost characteristics. 

Specifying Costs Components

Costs on a component can be specified by:
• a user with "Financial Controller" role, who has been declared 

responsible for the component in question;
• the Application Portfolio Manager:

You can define costs on the following  components HOPEX :
• Applications
• Application deployments
• Initiatives

One or several cost lines can be associated with a component. 
 A cost line enables identification of cost kind and type.

A cost line is characterized by:
• a type :  operating or capital.
• a nature: infrastructure (for a deployment), license (for an application), 

service, manpower.
• l’state of the life cycle of the component concerned, such as 

specification or development phases.

Associated with a cost line can be:
• a periodic expense
• one or several fixed expenses

Begin date End date Period cost Total cost 
obtained

7/1/2012 7/30/2012 500 500

7/1/2012 8/1/2012 400 900 

7/1/2012 9/1/2012 300 1200 

7/1/2012 10/1/2012 200 1400

7/1/2012 11/1/2012 100 1500 

7/1/2012 12/1/2012 0 1500 
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Creating a cost line

To associate costs with an application for example, you must begin by creating a
cost line. 

You can create cost lines singly, or automatically create three cost lines
corresponding to the three cost natures possible for an application: license, service,
manpower. 

To create a cost line for an application:
1. Open the properties pages of the application.
2. Select the Costs page.
3. In  Cost linesection, click the  New button.

The Creation of a cost line box opens.
4. To create a single cost line, select option Create only one cost line.
5. Click Next.
6. Specify the Nameof the cost line.
7. Select the Cost Type.. 
8. Select the Cost Nature.
9. Select the State of the application life cycle. 

 The states proposed in the drop-down list are states of the life cycle 
associated with the object life.

10. Click Next.
The periodic expenses creation dialog box opens.

 Fixed expenses, which can be multiple, are separately defined. For 
more details on fixed expense creation, see "Creating a fixed expense", 
page 39.

11. Define the periodic cost and click Next.
 For more details on fixed expense creation, see "Modifying a 
periodic expense", page 40.

12. Click OK.
The new cost line appears in the Cost Line.

Creating a fixed expense

Fixed expenses associated with a component are accessible from the component
properties pages, in the Costs tab. 

To create a new fixed expense on an application from a cost line:
1. Open the properties pages of the application.
2. Select the Costs page.
3. In the Cost Line section, select the cost line that interests you.
4. In the Fixed Expenses section, the list of fixed expenses associated 

with the cost line appears. In this section, click the New button.
The Creation of Expense dialog box opens.

5. Specify:
• the Name of the expense
• the Date of the expense,
• the Amount of the expense.

6. Click OK.
The new expense appears in the Fixed Expenses section.
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Modifying a periodic expense

To modify characteristics of a periodic expense associated with an application:
1. Open the properties pages of the application.
2. Select the Costs page.
3. In the Cost Line section, select the cost line that interests you.
4. Columns specific to the periodic expense are associated with the cost 

line:
• Periodic cost
• Periodicity
• Up/Down Amount

5. Click the column to be modified and enter the new value.
 If you indicate a negative amount, at each time period the amount 
will be deducted from the periodic cost until this reaches zero.

Specifying a Currency

At the level of each MEGA environment the currency used can be specified. The
monetary numeric format adapts as a result.

To modify currency:
1. In the MEGA installation folder, double-click the "Administration.exe" file.
2. Access your work environment.
3. Right-click the desired environment and select Options > Modify.

The options window appears.
4. In the navigator on the left, expand the Installation folder and select 

Currency.
5. On the right indicate the currency.
6. Click OK.

The format of costs is modified depending on the specified currency. Note also that
the format of figures depends on the interface language.
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